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Project 5: African Wildlife Poster

Stage 2  Compositing with Smart Objects

Your client provided a number of animal pictures that you can use in the � nished artwork. 

In Project 4, you learned the two basic methods for compositing � les into another � le — copy 

and paste (or drag) and placing a � le as a Smart Object. Your ultimate goal determines which of 

these methods is most appropriate for a speci� c job.

Smart Objects are layers that preserve source content, which means you can apply 

 non-destructive transformations to the layer. (Non-destructive means you do not alter 

the actual image data; you can restore the original image content, or make changes to 

the transformations that you apply, without negatively a� ecting the image quality.)

 Smart Objects also allow you to apply non-destructive image � lters. When you 

apply a Photoshop � lter to a regular layer, the pixels on the layer are permanently 

a� ected (unless you undo the � lter or step back through the History panel). Using 

Smart Objects means you can apply non-destructive � lters to a layer since you aren’t 

a� ecting the actual � le data.

COMPARE SMART OBJECT LAYERS TO NORMAL LAYERS

In this exercise, you apply layer masks and � lters to the client’s animal pictures. 

However, you don’t want to modify the actual photo � les, and you want to be able to 

change the � lter settings if the client doesn’t like the initial results. To accomplish both 

of these objectives, you will place the animal images as Smart Objects.

 1. With africa_working.psd open, choose File>Place. 

 2. Navigate to addax.tif in the RF_Design>Africa folder, click Place, and then press 

Return/Enter to � nalize the placement in the document window.

 3. Repeat Step 2 to place lion.tif into your working � le.

 4. Choose File>Open. Select giraffe.jpg and gorilla.tif and click Open.

 5. Use the  Arrange Documents panel in the Applications/Menu bar to show all 

three documents at once within the workspace.

We used the 

3 Up arrangement 

in the Arrange 

Documents panel.

In addition to placing 

� les as Smart Objects, 

you can also open a � le 

as a Smart Object in the 

File menu.

Note:

2project
Balloon Festival Artwork

Your client is the marketing director 

for the Temecula Hot Air Balloon 

Festival, which attracts thousands 

of tourists to the desert community 

throughout the three-day event. You 

have been hired to create the primary 

artwork for this year’s event, which 

will be used in a variety of di� erent 

products (ads, souvenirs, etc.).

� is project incorporates the following skills:

� Drawing complex custom shapes with the Pen tool

� Drawing irregular shape outlines by painting with the 

Blob Brush tool

� Editing anchor points and handles to control the precise 

position of vector paths

� Creating a custom color scheme using saved swatches

� Adjusting color, both globally and in speci� c selections

� Adding interest and depth with color gradients

� Saving multiple � le versions for various print applications
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Project Meeting
Here’s a basic synopsis of the movie:

Most American history books teach us that our 
“forefathers” were esteemed, venerable men who 
crafted the United States out of lofty and respected 
ideals. But there’s an old saying that history is 
written by the victors… In other words, who were 
these men really, and exactly how honorable were 
they? � e movie is about the events during and af-
ter the American Revolution — not the war itself, 
but the personal aspects that drove these individu-
als to do what they did. It’s not a war movie, and 
it’s not a political movie. It’s more a study of the 
human condition… How greed and power can 
corrupt even the most idealistic of men.

� is movie is going to be one of our sum-
mer blockbusters, and we’re throwing a lot of 
resources behind it. We’ll be putting the same 
ad in multiple magazines, and they all have 
slightly di� erent page sizes. We’ve forwarded 
the advertising specs for two of them to your 
art director, since those are the only ones we 
have right now.

� e client loved the initial concept sketch I 
submitted last week, so we’re ready to start 
building the � les. I’ve had the photographer 
prepare the images we need, and the client has 
provided the studio and rating logo � les. � ey 
also sent me the two magazines’ specs:

Magazine 1

–  Files should be submitted as native layout 
� les or layered TIFF; CMYK only

–  Bleed size: 8.75 × 11.25″

–  Trim size: 8.5 × 11″

–  Live area: 8 × 10.5″

Magazine 2

–  Files should be submitted as native layout 
� les or � attened TIFF; CMYK only

–  Bleed size: 8.25 × 10.25″

–  Trim size: 8 × 10″

–  Live area: 7.5 × 9.5″

To complete this project, you will:

� Create a single � le that can contain 
multiple page sizes

� Composite multiple images into a single 
background � le

� Incorporate both raster and vector elements 
into the same design

� Use selection techniques to isolate images 
from their backgrounds

� Transform and arrange individual layers to 
create a cohesive design

� Create layer groups and nested groups to 
easily manage � les

� Save two di� erent types of TIFF � les for 
di� erent ad requirements

211Project 4: Four-Color Movie Ad

CREATE THE NEW FILE

 1. On your desktop, copy the Liberty Ad folder from the WIP folder on your 
Resource CD to the WIP folder where you’re saving your work. 

Save all � les for this project in your WIP>Liberty Ad folder.

 2. In Photoshop, choose File>New.

If Clipboard is showing in the Preset menu, the new � le settings will match the current 
contents of the system clipboard (whatever you last copied in any application).  

You can create new � les  based on a number of included presets, including standard 
paper sizes (U.S. Paper, International Paper, and Photo) and standard sizes for di� erent 
devices (Web, Mobile & Devices, and Film & Video). 

If you choose one of these presets, the Size menu shows secondary options for the 
selected preset (such as Letter, Legal, or Tabloid for U.S. Paper). Choosing any of these 
presets automatically changes the values in the other � elds of the dialog box. 

 3. Highlight the Name � eld and type Movie Ad.

When you save the � le, the � le name defaults to the name you de� ne when you create 
the � le (in this case, “Movie Ad”). � e name you assign here also appears in the Window 
menu and on the document tab at the top of the document window.

 4. Press Tab to highlight the next � eld (Width) of the dialog box.

Similar to most applications, you can press Tab to move through the � elds of a dialog 
box. Pressing Shift-Tab moves to the previous � eld in the dialog box.

 5. Click the menu to the right of the Width � eld and choose inches.

When you change one unit of measurement (width), the other (height) changes too. 

The Image Size area 
shows the base file size 
of the file you’re defining. 
This number changes 
dynamically whenever 
you change an option in 
this dialog box.

Don’t worry about 
the default values. 

You’re going to 
define exactly what 

you need in the 
following steps.

� e New File dialog box 
defaults to the Clipboard 
preset (if you have 
anything copied) or to 
the last-used settings.

Note:

Choosing U.S. Paper 
in the Preset menu 
automatically converts 
the Width and Height 
measurement units 
to inches. Choosing 
International in the 
Preset menu changes the 
default measurement 
units to millimeters.

Note:

You can change 
the default unit of 
measurement in the 
Preferences>Units & 
Rulers dialog box.

Note:

Walk-Through

Visual Explanations
Wherever possible, screen shots 
are annotated so students 
can quickly identify important 
information.

Step-By-Step Exercises
Every stage of the workfl ow is 
broken into multiple hands-on, 
step-by-step exercises.

Real-World Workfl ow 
Projects are broken into logical lessons or 
“stages” of the workfl ow. Brief introductions at 
the beginning of each stage provide vital foun-
dational material required to complete the task.

Project Goals
Each project begins with a clear description 
of the overall concepts that are explained 
in the project; these goals closely match the 
different “stages” of the project workfl ow.

The Project Meeting
Each project includes the client’s initial 
comments, which provide valuable 
information about the job. The Project 
Art Director, a vital part of any design 
workfl ow, also provides fundamental 
advice and production requirements. 

Project Objectives
Each Project Meeting includes a 
summary of the specifi c skills required 
to complete the project.
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Project 8: HeartSmart Newsletter

� is project introduced a number of concepts and tools that will be very important as you work 

on more complex page layout jobs. Importing text content from other applications — speci� cally, 

Microsoft Word and Microsoft Excel — is a foundational skill that you will use in most projects; this 

newsletter showed you how to control that content on import, and then re-format it as appropriate in 

the InDesign layout. Templates, master pages, and styles are all designed to let you do the majority of work once and 

then apply it as many times as necessary; virtually any InDesign project can bene� t from these tools, 

and you will use them extensively in your career as a graphic designer. � is project provided a basic 

introduction to these productivity tools; you will build on these foundations as you complete the 

remaining projects in this book.

Replace a missing 
graphics file

Place images into template placeholders

Convert a one-color 
template to a 
four-color job

Import and format a 
large table from 
Microsoft Excel

Edit master page layouts

Apply master pages 
to layout pages

Access and edit 
master page items 

on layout pages

Replace a missing font

Import formatted 
text from a 
Microsoft Word file

Apply style sheets 
from the template

Control text wrap to move surrounding text away from frame edges

Control text frame inset to move contained text away from frame edges
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Adobe Illustrator CS4

Project Review

 1. Briefl y explain three ways to deselect the current selection on the Artboard.

 2. Briefl y explain the difference between the Selection tool and the Direct Selection tool.

 3. Briefl y explain the signifi cance of “process color” related to Illustrator artwork.

 1. The _______________ tool is used to place 

anchor points that are connected by line 

segments.

 2. The _______________ tool is used to change a 

smooth anchor point to a corner anchor point 

(and vice versa).

 3. The _______________ tool is used to edit 

individual anchor points (and their related 

handles) on a vector path.

 4. _______________ is the range of possible colors 

within a specifi c color model.

 5. _______________________________________ 

are the four component colors in process-color 

output.

 6. The _______________ panel includes value 

sliders for each component  in the defi ned 

color model.

 7. The _______________ is used to paint shapes 

of solid color based on the defi ned brush size 

and the area you drag with a single mouse 

click.

 8. The _______________ appears over a 

gradient-fi lled object when selected with the 

Gradient tool; you can use it to control the 

position and direction of color in the gradient-

fi lled object. 

 9. Changes made to a _______________ color 

swatch are refl ected in all elements where that 

color is applied.

 10. The _______________ dialog box can be used 

to change individual colors in an entire fi le, or 

make global changes to all colors in the fi le.
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Project 8: HeartSmart Newsletter

There are two kinds of pages in InDesign: 

• Layout pages are the pages on which 

you place text and images. 

•  Master pages are the pages on which 

you place recurring information, such 

as running heads (information at the 

top of the page) and running footers 

(information at the bottom of the page). 

Master pages are one of the most powerful 

features in professional layout software. 

Think of a master page as a template for 

individual pages; anything on the master 

appears on the related layout page(s). 

Changing something on a master layout 

applies the same changes to the object on 

related layout pages (unless you already 

changed the object on the layout page, 

or detached the object from the master).

Master pages are accessed and controlled in the top half of the  Pages panel. Layout pages, in the lower half of the panel, 

show the letter that corresponds to the master applied to that page. The Pages panel Options menu has a number of 

indispensable options for working with master pages: 
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Understanding Master Pages 

The letter indicates 

which master is 

applied to the page.

Selected page (the 

icon is highlighted)

Active page

(the page number is 

highlighted and bold)

Master pages

Layout page

•  New Master opens a dialog box where you can assign 

a custom prefi x, a meaningful name, whether the master 

will be based on another master page, and the number 

of pages (from 1 to 10) to include in the master layout.

•  Select Unused Masters highlights all master pages 

not associated with at least one layout page (and not 

used as the basis of another master page). This option 

can be useful if you want to clean up your layout and 

remove extraneous elements.

•  Master Options opens a dialog box with the same 

options you defi ned when you created a new master. 

•  Apply Master to Pages allows you to apply a specifi c 

master to selected pages. You can also apply a specifi c 

master to a layout by dragging the master icon onto the 

layout page icon in the lower half of the panel. 

•  Save as Master is useful if you’ve built a layout on a 

layout page and want to convert that layout to a master. 

Instead of copying and pasting the page contents, you 

can simply activate the page and choose Save as Master.

•  Load Master Pages allows you to import entire 

master page elements from one InDesign fi le to another. 

Assets such as colors and styles used on the imported 

masters will also be imported into the current InDesign 

fi le.

•  Hide/Show Master Items toggles the visibility of 

master items on layout pages.

•  Override All Master Page Items allows you to access 

and change master items on a specifi c layout page. (It’s 

important to realize that this command functions on a 

page-by-page basis.) You can also override individual 

objects by pressing Command/Control-Shift and clicking 

the object you want to override.

•  Remove All Local Overrides reapplies the settings 

from the master items to related items on the layout 

page. (This option toggles to  Remove Selected Local 

Overrides if you have a specifi c object selected on the 

layout page.)

•  Detach All Objects from Master breaks the link 

between objects on a layout page and objects on the 

related master; in this case, changing items on the 

master has no effect on related layout page items. 

(This selection toggles to  Detach Selection from 

Master if you have a specifi c object selected on the 

layout page.)

•  Allow Master Overrides on Selection, active by 

default, allows objects to be overridden on layout pages. 

You can protect specifi c objects by selecting them on the 

master layout and toggling this option off.
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Use what you learned in this project to complete the following freeform exercise. 
Carefully read the art director and client comments, then create your design to meet the needs of the project.
Use the space below to sketch ideas; when fi nished, write a brief explanation of the reasoning behind your design.

Portfolio Builder Project

Tantamount Studios is pleased with your work 
on the Forefathers ad, and they would like to 
hire you again to create the ad concept and � -
nal � les for another movie that they’re releasing 
early next year. 

To complete this project, you should:

�  Find appropriate background and 
foreground images for the movie theme 
(see the client’s comments at right).

�  Incorporate the title artwork, logos, and 
rating placeholder that the client provided.

�  Composite the di� erent elements into a 
single completed � le; save both a layered 
version and a � attened version.

 � e movie is titled Above and Beyond. Although the 
story is � ctionalized, it will focus on the men who 
led the � rst U.S. Airborne unit (the 501st), which 
su� ered more than 2000 casualities in the Euro-
pean theater of World War II.

We already have the title artwork, which we gave 
you in the RF_Builders>Airborne folder. 

 We don’t have any other images in mind, but the 
� nal ad should re� ect the time period (the 1940s) 
of the movie. � e 501st Airborne was trained to 
parachute into battle, so you should probably in-
corporate some kind of parachute image. 

 � is movie is another joint venture between Sun 
and Tantamount, so both logos need to be included 
in the new ad. It isn’t rated yet, so please use the 
“� is Movie Is Not Yet Rated” artwork (in the 
RF_Builders>Airborne folder) as a placeholder.

 Create this ad big enough to � t on an 8.5 × 11″ 
page, but keep the live area an inch inside the trim 
so the ad can be used in di� erent sized magazines.

Portfolio Builder Projects
Each step-by-step project is accompanied 
by a freeform project, allowing students to 
practice skills and creativity, resulting in an 
extensive and diverse portfolio of work.

Visual Summary
Using an annotated version of the 

finished project, students can quickly 
identify the skills used to complete 

different aspects of the job.

482 Adobe InDesign CS4

 8. Open the  Paragraph Styles panel (Window>Type & Tables>Paragraph Styles).

 9. Place the insertion point in the � rst paragraph of the imported story (the 
main heading) and look at the Paragraph Styles panel.

When you imported the Microsoft Word � le, you preserved the formatting in the � le; 
this is usually a good idea so you can see what the writer intended. However, now that 
the text is imported into your layout, you want to apply the template styles to make the 
text in this issue consistent with other issues.

When you import text into InDesign, any number of new styles may appear in the 
Styles panels; the most common imported style is Normal. Text in a  Microsoft Word � le 
is typically formatted with the  Normal style — even if you don’t realize it; user-applied 
formatting is commonly local (meaning it is applied to selected text instead of using a 
de� ned style).

� e imported text appears to be preformatted, but the Paragraph Styles panel tells a 
di� erent story. � is paragraph is formatted as “Normal+.” Whenever you see a plus 
sign next to a style name, the selected text includes some formatting other than what is 
de� ned in the style.

This icon indicates a style 
that was imported with 
the Microsoft Word file.

This file includes 
a number of 

styles for specific 
types of text.

New Style Group button

Clear Overrides

New Style

Delete

 10. With the insertion point still in place, click the Article Heading style in the 
Paragraph Styles panel.

Using styles, you can change all formatting attributes of selected text with a single click. 

 11. Place the insertion point anywhere in the � rst paragraph of body copy, and 
then drag to select the rest of the visible text in the 3-column frame.

You should be able to 
guess the purpose of these 
styles from their names. 
It’s always a good idea 
to use indicative names 
whenever you create styles 
or other user-de� ned 
assets.

Note:

You can reapply the basic 
style de� nition to selected 
text by clicking the  Clear 
Overrides button at the 
bottom of the Paragraph 
Styles panel, or by 
Option/Alt clicking the 
applied style name.

Note:

Paragraph styles can 
include character 
attributes as well as 
paragraph attributes; 
character styles can 
only de� ne character-
formatting attributes.

Note:

Design Foundations
Additional functionality, related tools,  
and underlying graphic design concepts  
are included throughout the book.

Advice and Warnings
Where appropriate, sidebars  
provide shortcuts, warnings, or 
tips about the topic at hand.

Project Review
After completing each project, students  
can complete these fill-in-the-blank and 
short-answer questions to test their under-
standing of the concepts in the project.
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 6 Menu Image Correction

o Retouching Damaged Images

o Correcting Lighting Problems

o Correcting Color Problems

o Preparing Images for Print
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 5 African Wildlife Map

o Setting Up the Workspace

o  Compositing 
with Smart 
Objects

o Using Filters and 
Adjustments

o  Creating 
an Artistic 
Background

o Creating Variations
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 4 Four-Color Movie Ad

o Setting Up the 
Workspace

o Compositing 
Images and 
Artwork

o Creating 
Silhouettes

o Managing 
Multiple Layers

o Saving Photoshop Files for Print
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 3 Identity Package

o Working with Gradient Meshes

o Working with Type 

o Working with 
Multiple Artboards

o Combining Text 
and Graphics
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 2 Balloon Festival Artwork

o Drawing Complex 
Artwork

o Coloring and 
Painting Artwork

o Exporting EPS 
and PDF Files
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 1 International Symbols

o Digital Drawing Basics

o Drawing Basics



vii

The Against The Clock Portfolio Series teaches graphic 
design software tools and techniques entirely within 
the framework of real-world projects; we introduce and 
explain skills where they would naturally fall into a real 
project workflow. For example, rather than an entire 
chapter about printing (which most students find boring), 
we teach printing where you naturally need to do so — 
when you complete a print-based project.

The project-based approach in the Portfolio Series 
allows you to get in depth with the software beginning 
in Project 1 — you don’t have to read several chapters 
of introductory material before you can start creating 
finished artwork. The project-based approach of the 
Portfolio Series also prevents “topic tedium” — in other 
words, we don’t require you to read pages and pages of 
information about type (for example); instead, we explain 
type tools and options as part of larger projects. 

Clear, easy-to-read, step-by-step instructions walk 
you through every phase of each job, from creating a new 
file to saving the finished piece. Wherever logical, we also 
offer practical advice and tips about underlying concepts 
and graphic design practices that will benefit students as 
they enter the job market.

The projects in this book reflect a range of different 
types of print design jobs using Adobe Illustrator, 
Photoshop, and InDesign. When you finish the ten 
projects in this book (and the accompanying Portfolio 
Builder exercises), you will have a solid foundational 
knowledge of the three most popular applications in the 
print design market — and have a substantial body of 
work that should impress any potential employer.
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 1
0 Combined Catalog

o	 Controlling Color for Output

o	 Placing and Controlling Images

o	 Controlling 
and 
Checking 
Text

o	 Editing 
Linked 
Files
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 9 Letterfold Catering Menu

o	 Building a Folding Template

o	 Working with 
Imported Text

o	 Editing 
Advanced Frame 
Options
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 8 HeartSmart Newsletter

o	 Working with 
Templates

o	 Working with 
Styles

o	 Working with 
Tables

o	 Preflighting 
and Packaging 
the Job
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 7 Festival Poster

o	 Building Graphic Interest

o	 Importing and 
Formatting Text

o	 Graphics as 
Text and Text as 
Graphics

o	 Outputting the 
File
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